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Preface 

Mail for Macintosh lets you exchange electronic mail with other users on your computer 
network. It is one component of PATHWORKS for Macintosh, a set of application 
programs and utilities that lets you use your Macintosh computer to access services on 
Digital networks. Mail for Macintosh provides access to P A THWORKS mail servers. Other 
services that you can access are described in the PATHWORKSjor Macintosh: Network 
Services User's Guide. 

What you need to know 

This guide assumes that you have already installed PATHWORKS for Macintosh as 
described in the Network Services User's Guide and that you are familiar with that book. 

Summary of contents 

The following list summarizes the contents of this guide: 

• Chapter 1, "Getting Started," tells you how to install the Mail for Macintosh software 
on your computer and how to start the program and set your preferences. The 
chapter also tells you how to log in to a mail server on the network. 

• Chapter 2, "Creating and Sending Mail," tells you how to create, save, and edit a 
memo, and how to send a memo to other people on your network. 
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• Chapter 3, "Receiving Mail," describes how to open and read memos that other users 
send to you. The chapter also explains how to reply to a memo and how to forward a 
memo to another user. 

• Chapter 4, "Organizing Your Mail," explains how to use the folders created by the 
Mail for Macintosh program to organize your mail. This chapter tells you how to copy, 
mark, and delete a memo, and how to save a memo on a disk. 

• Chapter 5, "Quitting," tells you how to conclude a session by logging out of a mail 
server or by quitting the Mail for Macintosh program. 

• Appendix A, "Menu Reference," describes the function of each of the menu 
commands in the Mail for Macintosh program. 

• Appendix B, "Troubleshooting," suggests solutions for problems that you might have 
when using Mail for Macintosh. 

Conventions used in this guide 

The Courier font is used to indicate computer commands and text that you type. 

Terms that have a special meaning in relationship to Macintosh or Digital computers, or 
to networks, appear in boldface when first defined in the text. These terms are also 
defined in the glossary. 

• Note Text set off in this manner presents sidelights or interesting points of 
information. + 

Terminology 

This guide uses the terms mail, electronic mail, memo, and message more or less 
interchangeably. All of these terms refer to text that you send or receive through the mail 
server. 
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For more information 

If you are unfamiliar with computer networks, you may want to read Appendix A in the 
Network Services User's Guide, which provides basic information about networks. 

For more information about mail services, see the VMS General User Volume 2B, Using 
V1l1S, "VMS Mail Utility Manual." 
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1 Getting Started 

This chapter introduces the Mail for Macintosh application program and your mail server 

account. The chapter tells you how to install Mail for Macintosh on your computer, start 

the program, choose and configure a connection tool, and log in to a mail server. The 

chapter also tells you how to use the Mail for Macintosh on-screen help system and how 

to set your preferences for how certain Mail for Macintosh features work. 



About Mail for Macintosh and your mail 
server account 

The Mail for Macintosh program allows you to use electronic mail services on Digital 
networks. You use Mail for Macintosh to log in to a mail server and exchange mail with 
other users on the network. 

Before you can log in, however, your system administrator must set up an account for 
you on the mail server. The account includes your user name, password, and a special 
directory on the host computer, which keeps track of your electronic mail. If you do 
not have an account, see your system administrator. Be sure to get your user name and 
password, and the name of the host computer to which you'll connect. 

Mail for Macintosh can connect to the host computer by means of either the 
AppleTalk-DECnet Connection Tool or the DECnet Connection Tool. See the section 
"Specifying and Configuring a Connection Tool," later in this chapter, for a discussion on 
which type of connection to use. 

Hardware, system software, and 
networking software requirements 

The hardware and software requirements for you to use Mail for Macintosh are the same 
as those for using other components ofPATHWORKS for Macintosh. Like other 
components of PATHWORKS for Macintosh, Mail for Macintosh requires that you have an 
appropriate communications tool installed. A communications tool supplies the 
communications functions that your Macintosh needs to communicate with another 
computer. 
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Hardware requirements 

You must have, at a minimum, the following configuration: 

• One of the following Macintosh computers: 
o Macintosh Plus 
o Macintosh Classic 
o Macintosh LC 
o Macintosh Portable 
o any of the Macintosh SE family 
o any of the Macintosh II family 

• 1 megabyte (MB) of memory; 2 MB for system software version 7.0 

• one hard disk drive or two floppy disk drives 

Although you can use Mail for Macintosh with a single floppy disk drive, a hard disk 
is recommended. This guide assumes that you are using a hard disk drive. 

System and networking software requirements 

Your Macintosh computer must have the following software installed before you can 
install and use Mail for Macintosh: 

• system software version 6.0.4 or a later version of 6.0.x, or system software 
version 7.0 (x refers to any appropriate version number) 

• AppleTalk® Phase 2 network software 

• EtherTalk® 2.0 (if you are connected to the network through an Ethernet card) 

Installing Mail for Macintosh 

This section provides only a summary of the procedures for installing the Mail for 
Macintosh program and related communications software. Detailed instructions are 
available in the Installation part of the Network Services User's Guide. That guide 
describes how to install Mail for Macintosh and all other components ofPATHWORKS for 
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Macintosh. If you have not yet installed the Mail for Macintosh program and the 
connection tools you want to use, follow the instructions provided in that guide. 

All P ATIIWORKS for Macintosh software components are installed using the 
P A THWORKS Installer application program. You can use the Installer in either of two 
ways. 

Easy Install method The Easy Install method installs a number of PATIIWORKS 
components, including the Mail for Macintosh program and the AppleTalk-DECnet 
communications software. Unless you want to use a DECnet connection, the Easy Install 
method installs everything you need to use Mail for Macintosh. To use the Easy Install 
method, click the Install button in the Easy Install dialog box. 

Customize Install method The Customize Install method lets you select the specific 
components that you want to install. Clicking the Customize button in the Easy Install 
dialog box displays the custom-install dialog box with a list of PATHWORKS 
components. You specify the components that you want to install by selecting items in 
the list. Select "Mail for Macintosh 1.0 support" to specify installation of both the Mail for 
Macintosh program and the AppleTalk-DECnet communications software. Select "DECnet 
for Macintosh 1.0 support" to specify installation of the DECnet communications 
software. (Shift-click to select both items at once.) To install the software, click the 
Install button to the right of the list. 

Selecting a network connection 

Mail for Macintosh-like the other components ofPATHWORKS for Macintosh-provides 
access to network services. Because your Macintosh may be connected to more than one 
network, or connected to the same network in different ways, you may need to select a 
network connection before starting the Mail for Macintosh program. For example, your 
computer may be connected to a LocalTalk network and also contain an Ethernet card 
that connects it directly to an Ethernet environment. Or your computer may contain 
multiple Ethernet cards, each card connecting it to a different Ethernet environment. 

You can access senrices on only one network at a time, so if your Macintosh is 
connected to multiple networks, you must specify the network that has the mail server 
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that you want to use, before you can log in to that server. (If you're not sure which 
network has the server that you want, ask your system administrator.) 

The procedure that you follow to select a network connection depends on whether 
you are using Macintosh system software version 6.0.xor version 7.0. This section gives 
the procedure for each environment. 

If you have system software version 6.0.x 

To select a network connection on a Macintosh computer running system software 
version 6.0.x: 

1 Choose Control Panel from the Apple (tt) menu. 

The Control Panel dialog box appears. 
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2 Select the Network icon from the group of icons on the left side of the Control 
Panel window. 

You may have to scroll through the list to find the Network icon. 
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3 Select the icon for the network that has the mail server that you want to use. 

The Control Panel displays a separate icon for each network to which your Macintosh is 
connected. 

A connection to a LocalTalk network is usually made through the printer port. The icon 
for this type of connection is shown in the preceding figure with the label "Built-in." 

A connection to an Ethernet environment is represented by an icon labeled "EtherTalk." 
If your Macintosh is connected to more than one Ethernet environment, each EtherTaIk 
icon is also labeled with a number in parentheses, indicating the slot that contains the 
Ethernet card for that connection. 

4 Close the Control Panel dialog box. 

If you have system software version 7.0 

To select a network connection on a Macintosh computer running system software 
version 7.0: 

1 Choose Control Panels from the Apple (tt) menu. 

The Control Panels window opens. This window displays icons representing the various 
control panels installed on your Macintosh computer. 
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2 In the Control Panels window, double-click the Network icon. 

You may have to scroll through the window to find the Network icon. 

The Network panel opens. This panel contains a separate icon for each network to which 
your Macintosh is connected. 

Network 

Select an AppleTalk connection: 

~ 
LocalTalk 
Built-In 

3 Select the icon for the network that has the mall server you want to use. 

A connection to a LocalTalk network is usually made through the printer port. The icon 
for this type of connection is shown in the preceding figure with the label LocalTalk 
Built-in. 

A connection to an Ethernet environment is represented by an icon labeled EtherTalk. If 
your Macintosh is connected to more than one Ethernet environment, the name of each 
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EtherTalk icon includes a number in parentheses, indicating the slot that contains the 
Ethernet card for that connection. 

4 Close the Network panel and the Control Panels window. 

Starting Mail for Macintosh 

You start Mail for Macintosh just as you start any other Macintosh program-by double
clicking the program icon on the Macintosh desktop or by selecting the icon and 
choosing Open from the File menu. Figure 1-1 shows the Mail for Macintosh program 
icon. 

~:~ .. ~ 
Mail For Macintosh 
Figure 1-1 TheMail for Macintosh program icon 

The first time that you run the Mail for Macintosh program, the Connection Configuration 
dialog box appears. You use this dialog box to choose and configure a connection tool, 
as described in the next section. When you finish configuring a tool, the Login dialog box 
appears to let you connect to the server. "Logging In to the Mail Server," later in this 
chapter, describes this process. 

After you've used Mail for Macintosh for the first time, the Login dialog box appears 
when you start the program, and you can connect to the server immediately. 

Specifying and configuring a connection 
tool 

Before you can log in to the mail server, you must tell Mail for Macintosh which 
connection tool you want to use to communicate with the server, and supply the 
connection tool settings that allow this communication to take place. 
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Mail for Macintosh supports both the AppleTalk-DECnet Connection Tool and the 
DECnet Connection Tool. Which connection method you'll want to use depends on a 
variety of factors. If you have already installed the DECnet Connection Tool on your 
Macintosh computer, you'll probably want to use that tool with Mail for Macintosh. 
DECnet connections perform slightly better than AppleTalk-DECnet connections and use 
fewer resources on the server. On the other hand, the DECnet software takes up more 
disk space on your Macintosh disk drive than the AppleTalk-DECnet software. DECnet 
also requires more available RAM on your Macintosh. Therefore, if you have not installed 
the DECnet Connection Tool for use with some other network service or if you have 
limited RAM, you'll probably want to use the AppleTalk-DECnet Tool with Mail for 
Macintosh. You may want to talk to your system administrator about which connection 
method to use. 

When you first open the Connection Configuration dialog box, its contents depends on 
which connection tools you have installed: 

• If the DECnet Connection Tool is available, the dialog box contains the connection 
settings for that tool. 

• If the DECnet Connection Tool is not available but the AppleTalk-DECnet Tool is, the 
dialog box contains the settings for the AppleTalk-DECnet Tool. 

• If neither tool is available, Mail for Macintosh displays the alert shown in Figure 1-2. 
To use Mail for Macintosh, you need to install one of the connection tools. See 
"Installing Mail for Macintosh" earlier in this chapter. 

Mail for Macintosh requires 
installation of either the DEC net Tool 
or the RppleTalk-DECnet Tool. 

OK 

Figure 1-2 The alert for no available connection tools 
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If you want to use the DEenet Connection Tool 

To specify and configure the DECnet Connection Tool: 

1 Open the Connection Configuration dialog box. 

Start the Mail for Macintosh program or, if you have already started the program and the 
Connection Configuration dialog box is not on your screen, choose Connection from the 
Server menu. 

2 If the settings for the DECnet Tool do not already appear, choose DECnet Tool 
from the Method pop-up menu. 

The lower part of the dialog box changes to display the connection settings for the 
DEenet Tool. 

Connection Configuration 

Method: I DECnet Tool 

User: I Smi th 

mamamma 
DECnet for Macintosh 

Node: I MED I 0 

( Cancel) 

([ OK ]1 

Node Names 

DUEV 
HAL 

-~mI;~·I;II;v:···I: 
SPINNV ~ 

Version 1.1 Copyright © 1991 Thursby Software Systems, Inc. 

3 Enter your user name in the User field. 

Your user name is the name of the account created for you by the system administrator. 
Your system administrator should have given you a user name and an account 
password, which you'll need when you log in. 

4 In the Node Names list, choose the node name of the host computer running 
the mail server that you want to use. 
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The node name that you choose appears in the Node field to the left of the list. If the 
Node Names list is long, you may find it more convenient to type the node name directly 
into the Node field. If you don't know the node name of the host computer, ask your 
system administrator. 

5 Click the OK button. 

The Login dialog box appears, to let you connect to the server. Skip to "Logging In to the 
Mail Server," later in this chapter, to learn how to log in. 

Moil Seruer Login 

Seruer Nome: I MEO I 0 I 
User Nome: I ,-S-M-IT-H-------. 

Possword: 1:...11 _______ ----1 

( Work Offline) I( Login )) 

If you want to use the AppleTalk-DECnet Connection 
Tool 

To specify and configure the AppleTalk-DECnet Connection Tool: 

1 Open the Connection Configuration dialog box. 

Start the Mail for Macintosh program or, if you have already started the program and the 
Connection Configuration dialog box is not on your screen, choose Connection from the 
Server menu. 

2 If the settings for the AppleTalk-DECnet Tool do not already appear, choose 
AppleTalk-DECnet Tool from the Method pop-up menu. 

The lower part of the dialog box changes, to display the connection settings for the 
AppleTalk-DECnet Tool. There are three different groups of settings for the tool. The 
group that appears depends on which of the icons along the left side of the dialog box is 
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selected. (The steps that follow explain how to configure the Gateway and Service 
settings; you do not need to configure the Identity settings.) 

Connection Configuration [ cancel) 

Method: I RppleTalk-DECnet Tool I[ OK )1 
User: ,-I s_m_it_h ___ ...... 

Specify an AppleTalk-DECnet Gateway 

Service 

~ 
::L 
identity 

Zone: " 4 I Gateway :1,-_____ --' 
Amsterdam {} 

5!~ I 
.~I~I~·:·:·.sc·o .......... 1 
Sin<lapore {} 

Pearly 
Heaven 
Golden 

3 Enter your user name in the User field. 

Your user name is the name of the account created for you by the system administrator. 
Your system administrator should have given you a user name and an account password, 
which you'll need when you log in. 

4 Make sure that the Gateway icon is selected (at the far-left side of the dialog 
box), then specify the zone and gateway for the mail server you want to use. 

If the Gateway icon was not already selected, the dialog box changes to show the 
available zones in a list below the Zone field. When you select a zone, the available 
gateways for that zone appear in the list below the Gateway field. If you aren't sure 
which zone and gateway to choose, see your system administrator. 
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Connection Configuration ( Cancel 

Method: I RppleTalk-DECnet Tool (( OK )) 

User: I Smi th 

Specify on AppleTolk-DECnet Gotewoy 

Service 

~
::: .. 

I!;;..J 

: : 

Identity 

Zone: Ii , 

Amsterdam {}-

~~, I 
--~m~·;~·:·:·sc·o ........ ·1 
SinQaport' -0. 

Gateway: L..-I _____ --1 

Pt'arly 
Heavt'n 
Goldt'n 

If the network contains a large number of zones, you may find it more convenient to type 
the zone name in the Zone field. As soon as you've typed enough characters to identify 
the zone, its name is selected automatically in the list. The Gateway list works in a similar 
fashion. 

If your network is not divided into zones, an asterisk (*) appears in the Zone field and the 
list is empty. You need only select a gateway in the list on the right. 

5 Select the Service icon in the list at the far-left side of the dialog box, then enter 
the node name of the host computer running the mail server that you want to 
use. 

The lower part of the dialog box changes to display the object and node for a DEenet 
service. Because Mail for Macintosh only connects to PATHWORKS mail servers, the 
objectname-PCSA$MAI L-is already filled in. If you don't know the name of the 
node, ask your system administrator. 
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Connection Configuration ( Cancel] 

Method: I RppleTalk-DECnet Tool 
([ OK 11 

User: L...I S_m_it_h ___ --I 

Speci fy 8 DECnet SerYl ce 

~ ~ , ............................................................................................................................ : 
~ ®~~ ~ Gateway 

l. ... ~.~.~:=~ ............ : ..... ~~~.~.~.~.~.I.~ .......................... f~.~~~~~.::~ .... ..! 
+ Node 

Service 

'=
"' .. 
~ 

: : 
Identity 

6 Click the OK button. 

The Login dialog box appears to let you connect to the server. The next section tells you 
how to log in. 

Mail Seruer Login 

Seruer Name: 1 MED 10 I 

User Name: 1..-1 S_M_IT_" _______ --' 

Password: 1L.:....1 ________ --' 

Work Offline I( Login )) 

Logging in to the Mail server 

The Login dialog box appears when you finish choosing and configuring a connection 
tool. After the first time that you use Mail for Macintosh, the Login dialog box appears 
whenever you start the program. 
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You must use this dialog box to log in to the mail server. If the dialog box is not on 
your screen, you can display it by choosing Login from the Server menu. 

To log in to the mail server: 

1 Open the Login dialog box. 

Start the Mail for Macintosh program or, if you have already started the program and the 
Login dialog box is not on your screen, choose Login from the Server menu. 

The Login dialog box appears, as shown in the following figure. The Server Name and 
User Name fields will already be filled in with the information you entered in the 
Connection Configuration dialog box. 

Mail Seruer Login 

Seruer Name: 1 MED I 0 1 

User Name: '-1 s-M-n-H----------. 

Password: 

( Work offline) I( Login )1 

2 Enter your password. 

Use the password assigned by your system administrator for your account on the server. 
To prevent onlookers from learning your password, the characters that you type do not 
appear in the dialog box. Instead, Mail for Macintosh displays a bullet for each character 
that you type. 

If you've logged in successfully, the Mail Directory window for your account on the mail 
server appears, as shown in Figure 1-3. 
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Mail Directory E!1Si 
Folder Date From Subject 

-0-
181 1 28-JRN-1991 MEDIO: : SYSADMIN FWD: We I come 

L:J MRIL 

~ 
¢II I¢ I2J 

Figure 1-3 TheMail Directory window 

Now you can send mail to other users on the network, and read mail that you receive 
from them. Chapters 2 and 3 tell you how. 

Problems logging in 

If you have trouble logging in to the mail server, it's probably because of one of the 
following conditions: 

• You entered an incorrect user name, password, or both. 

• There is a problem with the network or server. 

If an error message indicates a problem with the user name or password, then try 
logging in again. Be careful to enter your correct user name and password. If the error 
message indicates a problem with the network or server, tell your system administrator 
about the error that you are getting. 

Appendix B provides more detailed troubleshooting hints. 
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About the Mail Directory window 

The Mall Directory window contains your electronic mail (in the form of memos) and 
folders that help you organize your mail. Folders appear at the extreme left side of the 
Mail Directory window. A folder can be either open or closed. You open a folder by 
selecting it and choosing Open Folder from the Folder menu, or by double-clicking the 
folder's icon in the Mail Directory window. You can have only one open folder at a time; 
when you open a folder, the previously opened folder Of any) is closed. Figure 1-4 shows 
the Mail Directory window with one opened and two closed folders. 

Mail Directory 
Folder Date From 

f::J NEWMRIL 

121 1 29-NOU-1990 MED I 0: : ORS I NO 
121 2 4-DEC-1990 MED I 0: : ORS I NO 
121 3 22-JRN-1991 MED I 0: : SYSADM I N 

f::J WRSTEBRSKET 

¢ 

Subject 

Treatise on tomatoes 
Best restaurants in town 
Welcome 

Figure 1-4 Folders in the Mail Directory window 

0-

When a folder is opened, its contents-a set of memos-appear below the folder, slightly 
indented. 

For each memo, the Mail Directory window displays several pieces of information, as 
show~ in Figure 1-5. 

Status Number Date Sender Subject 

Figure 1-5 A memo line in the Mail Directory window 
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The following list describes each type of information: 

Status 

Number 

Date 

Sender 

Subject 

The status of the memo-whether or not you've read the memo, if 
you've moved the memo, if you've deleted the memo, and if you've 
marked the memo. See Table 1-1 for a description of the each of the 
status icons. 

The number of the memo in the current folder. 

The date the memo was sent. 

The full user name of the person who sent the memo-including both 
the node and user name. 

A brief description of the memo's contents. 

Note that the check mark (indicating a marked memo) appears beside the other icons in 
the Mail Directory window. 

Table 1-1 Memo status icons 

Icon Description 

LEiI New memo-one that you haven't read yet. (See "Reading a Memo" in Chapter 3.) 

~ Memo that you've read. 

L:.:::~~ Memo that's been moved to another folder. (See "Moving a Memo" in Chapter 4. 

1fiit Memo marked for deletion. (See "Deleting a Memo" in Chapter 4.) 

" Marked memo. (Marking a memo lets you perform actions on several memos at once. 
See "Marking or Unmarking a Memo" in Chapter 4.) 
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Getting help 

Mail for Macintosh includes an on-line help document called Help. You may want to use 
the Mail for Macintosh help system, along with this guide, while you are learning how to 
use the product. 

To use the Mail for Macintosh help system: 

1 Choose Help from the Apple menu. 

The Mail for Macintosh Help window appears. 

Welcome to Mai I for Macintosh 
Help. The Mail for Macintosh 
Help offers on-I ine information 
abou t Ma i I for Mac intosh and 
each of i ts menu items. 

To use Mal I for Macintosh Help, 
doub I e-c lick the top icon the 
right hand side of the Help box 
that you want information on. 
The Help text for that topic 
wi II appear on the left side of 
the Help box. 

Help 

~ Keyboard Shortcuts 
Pre f erence Se t t i ngs 
The Mail Directory Window 
The New Memo Window 
The Read Memo Window 
Creat i ng and Send i ng a Memo 
Reading Memos 
Replying to a Memo 
Mark i ng Memos 
RII Rbout Folders 
Creating a new folder 
Oeleting a folder 

Done 

2 Select a topic from the list on the right and click the Help button (or double
click the topic). 

The help text for the topic you selected appears in the field on the left side of the 
window. 

3 Click the Done button when you've fmished with the help system. 
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Setting your preferences 

Setting your preferences means specifying how you want certain Mail for Macintosh 
features to work. Mail for Macintosh comes with preset settings for these features. You 
can change these settings at any time by using the Preferences dialog box. 

Mail for Macintosh saves most of the preferences settings in a document called Mail 
for Macintosh Preferences, which is stored in your System Folder. Because these settings 
are stored on your Macintosh, you can change them whether or not you are logged in to 
the server. One of the settings, an address for forwarding your mail, is stored on the mail 
server. You must log in to the server to specify or change the forwarding address. This 
section describes each of the preferences settings and tells you how to change them. 

Mail for Macintosh creates the preferences document automatically the first time that 
you run the program. If for some reason the document is removed from the System 
Folder, Mail for Macintosh re-creates it the next time you run the program. When Mail for 
Macintosh re-creates the preferences document, it uses the preset settings that come with 
the program. If you find different settings more convenient, you will have to set your 
preferences again. 

To set your preferences: 

1 Choose Preferences from the Mail menu. 

The Preferences dialog box appears. 

Preferences 

Personal Name: 

Forwarding Rddress: 

Wastebasket Name: ,-I W_A_S_TE_B_A_SK_E_T _____ ---' 

[8/ Move opened memos to MAIL folder 

o Confirm Save after sending new memo 

o Include text on Reply 

( Cancel) 
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2 Enter or change the preferences information and set the options to meet your 
needs, then click the OK button. 

The subsections that follow describe each of the settings in the Preferences dialog box. 

Personal Name 

If you want a personal name to appear automatically on your memos, enter it in this field. 
You can enter up to 255 characters. This text will appear by default to the right of your 
user name at the top of new memos that you open. (If you want to use a different 
personal name for a specific memo, you can replace the default text directly in the memo 
window.) 

You can use the personal name field to include information such as 

• your full name (Silvio Z. Orsino) 

• useful information (Irina Spatsky, Programmer, Tel. 555-4321) 

• a witty phrase (Pay no attention to that man behind the curtain.) 

• Note The contents of the personal name field are stored in the Mail for Macintosh 
Preferences document. Entering a person name in the Mail for Macintosh Preference 
dialog box will not interfere with any personal name that you may have associated with 
your mail server account. + 

Forwarding Address 

You c~n forward your incoming mail to another mail server account. Type the name of 
the account to which you want mail forwarded in the Forwarding Address field. The 
server will forward your mail. When you want the server to stop forwarding your mail, 
delete the address from this field. You must be logged in to the server to specify, change, 
or delete the forwarding address. 
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Wastebasket Name 

The WASTEBASKET folder is a folder on the mail server that contains your deleted 
memos. Some VMS programs external to Mail for Macintosh, such as DECwindows Mail 
and VMS Mail, allow you to change the name of the server's WASTEBASKET folder. If 
you've changed the name of the WASTEBASKET folder, you must enter the new name in 
the Preferences dialog box. Otherwise, the Delete Memo command and the Purge 
Deleted Memos command in the Mail menu will not work. 

Mail defaults 

The check boxes in the lower part of the Preferences dialog box let you choose default 
actions associated with sending and receiving mail. Check the defaults that you want to 
use. 

Move opened memos to MAIL folder When this box is checked, Mail for Macintosh 
automatically moves memos from the NEWMAIL folder to the MAIL folder as you read 
them. This feature helps you keep track of which mail you've read and which you 
haven't. See Chapter 4, "Organizing Your Mai1." Note that if you delete a memo after you 
read it, it will not be moved to the MAIL folder, even if this option is selected. Mail for 
Macintosh comes with this feature activated (checked). 

Conflml Save after sending new memo This feature allows you to choose whether 
you want Mail for Macintosh to prompt you to save a memo that you've sent (and that 
you haven't already saved) when you close the memo window. When this box is 
checked, Mail for Macintosh always prompts you to save unsaved memos. When this box 
is not checked, Mail for Macintosh does not prompt you to save a memo that's been sent. 
If you have checked the Copy on Send default, you may want to deactivate this feature, 
because a copy of each memo that you send is saved automatically in your NEWMAIL 
folder on the mail server. Mail for Madntosh comes with this feature deactivated 
(unchecked). 

Include text on Reply When this box is checked, Mail for Macintosh automatically 
copies the text of any memo to which you reply into the reply itself. You may, for 
example, want to include the original message in your reply so that the sender can see 
the context of your response. Of course, you can edit the copied text just as if you'd 
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typed it in yourself. (Perhaps you only want to include a portion of the original message.) 
See "Replying to a Memo" in Chapter 3. Mail for Macintosh comes with this feature 
deactivated (unchecked). 

Copy on Send When this box is checked, Mail for Macintosh automatically adds your 
name to the copy (CC) field of every memo that you write. When you send the memo. a 
copy appears in your NEWMAIL folder the next time you log in to the mail server or 
when you choose Check for New Mail from the Folder menu. See "Sending a Memo" in 
Chapter 2. Figure 1-6 shows the address area of a memo with the copy field already filled 
in. Mail for Macintosh comes with this feature deactivated (unchecked). 

Untitled-2 

From: SMITH /Steven s. Smi th, CommuniTree Group I 
To: ~I ------~==========================~I 

CC: ISMITH I 

Subject: I I 

Figure 1-6 A copy address automatically filled in by Mail for Macintosh 

Copy on Reply When this box is checked, Mail for Macintosh automatically adds your 
name to the copy (CC) field of every reply that you write to an incoming memo. When 
you send the reply. a copy appears in your NEWMAIL folder the next time you log in to 
the mail server or when you choose Check for New Mail from the Folder menu. See 
"Replying to a Memo" in Chapter 3. Figure 1-6 shows the address area of a memo with 
the copy field already filled in. Mail for Macintosh comes with this feature deactivated 
(unchecked). 

Copy on Forward When this box is checked, Mail for Macintosh automatically adds 
your name to the copy (CC) field of every memo that you forward to another user on the 
network. When you forward the memo. a copy appears in your NEWMAIL folder the next 
time you log in to the mail server or when you choose Check for New Mail from the 
Folder menu. See "Forwarding a Memo" in Chapter 3. Figure 1-6 shows the address area 
of a memo with the copy field already filled in. Mail for Macintosh comes with this feature 
deactivated (unchecked). 
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Logging in to a different server 

If you have an account on more than one mail server, you may want to log out of one 
server and in to another. Several steps may be involved. The new mail server may be on 
another host computer, for example, to which you must connect through a different 
gateway. You may even need to use a different connection tool. It's likely that you will 
need to repeat several of the procedures described earlier in this chapter. The following 
procedure provides a summary of the tasks involved. 

To log in to a different mail server: 

1 Choose Logout from the Server menu to log out of the current server. 

2 (optional) Select a new network connection. 

See "Selecting a Network Connection," earlier in this chapter. 

3 Choose and configure a new connection tool, or reconfigure the current 
connection tooL 

See "Specifying and Configuring a Connection Tool," earlier in this chapter. 

4 Log in to the new server. 

See "Logging In to the Mail Server," earlier in this chapter. If you want to temporarily 
connect to another server or use a different account, you can do so by entering the new 
server and user names in the Login dialog box. Note that specifying a different server or 
user name in the Login dialog box does not alter the default connection settings specified 
in the Connection Configuration dialog box. 
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2 Creating and Sending Mail 

This chapter tells you how to create memos and send them to other users on your 

network. This chapter also tells you how to save memos as text files, open text files to 

send as memos, edit memos, and print memos. 



Creating a memo 

You can create a memo in either of two ways: 

• Create a memo with Mail for Macintosh. 

• Open a text file created with a word-processing program. 

Mail for Macintosh lets you open and send text documents that you've created with 
Microsoft Word, MacWrite@, and other Macintosh word-processing programs. The 
following procedure tells you how to create a memo with Mail for Macintosh. Creating a 
memo from a word-processing document is described in "Opening a Saved Memo or 
Text File," later in this chapter. 

To create a memo with Mail for Macintosh: 

1 Choose New Memo from the File menu. 

A new, untitled memo window appears. (The following figure shows that the Copy on 
Send preference is activated because the sender's user name appears in the CC field. See 
"Mail Defaults" in Chapter 1.) 

=0 Untitled-l 

From: SMITH ISteven S. Smith, CommuniTree Group I 

To: ~I ------~============================~I 

CC: ISMITH I 

Subject: I I 

2 Address the memo. 
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Enter addressing information in the following fields. You can move from field to field 
by pressing the Tab key, or use your mouse to place the insertion point by clicking. 

From: Mail for Macintosh automatically shows the user name that you provided in the 
Connection Method dialog box. You can include additional information (such as your full 
name and telephone number) by entering it in the field to the right of the user name. (To 
have Mail for Macintosh automatically include this kind of information, see the "Personal 
Name" section in Chapter 1.) 

To: Enter the user name (or names) of the person (or people) to whom you want the 
memo sent. You must already know the mail server account user name for each person. 
(If you don't know a person's user name, you'll have to ask for it.) If the account is on a 
different node from yours, you must precede the user name with the node name and two 
colons (nodeName: : userName). If you enter more than one user name, set off each 
name with a comma or space. (If you are a VMS user, you can address a memo to a list of 
people. See "Using a Distribution List," later in this chapter.) 

cc: If you want to send a copy of the memo to one or more people, enter their user 
names in this field, sometimes known as the Copy field. Again, if you enter more than one 
name, set off each name with a comma or space. 

Subject: Indicate the subject of the memo. (Filling in this field is optional, but it's 
customary to provide a brief label for the memo.) 

3 Type your memo. 

Enter the text for your memo in the area below the double line. You can type as long a 
message as you like-the only limit is the memory available to the Mail for Macintosh 
program. 

Sending a memo 

Once you've created and addressed a memo, as explained in the preceding section, 
sending it is easy. 
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To send a memo: 

1 Log in to the mail server. 

If you haven't already logged in to the server, see "Logging In to the Mail Server" in 
Chapter 1. 

2 Make sure that the memo window is open and that it is the frontmost window 
on your screen. 

3 Choose Send Memo from the Mail menu. 

Using a distribution list 

If you are a VMS user, you can create a list of people to whom you regularly send mail 
and use it as a distribution list. You must give the distribution list a name. Mail for 
Macintosh lets you use that list to send a memo to a group of people without having to 
type each person's user name when you address the memo. (See the VMS General User 
Volume 2B, Using VMS, "VMS Mail Utility Manual.") 

To address a memo by using a distribution list: 

• In the To field, type an "at" sign (@) followed by the name of the distribution 
list. 

For example, enter 

@FRIENDS 

Do not type a space between the "at" sign and the list name. 

Saving a memo on a disk 

You can save a copy of your memo as a text file on any disk drive accessible to your 
Macintosh computer by using the Save and Save AB menu commands. The Mail for 
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Macintosh Save and Save As commands behave the same way that they do in other 
Macintosh programs. 

To save a memo (for the first time): 

While the memo window is open and frontmost, choose Save As (or Save) from 
the File menu. 

The standard Save-As dialog box appears. Mail for Macintosh automatically displays the 
subject of the memo (truncated to 32 characters). 

If you want to save the rue with a different name, enter the name. 

Click the Save button. 

Mail for Macintosh saves your memo as a standard text document. Later on, you can 
reopen the memo, edit the memo if you choose, and then send it as electronic mail to 
other users on the network. 

After you've saved a memo the first time, you can update the text file whenever you've 
made changes to your memo by choosing Save from the File menu. Mail for Macintosh 
automatically updates the text file. You can also save another copy of the memo with a 
new name by choosing Save As from the File menu. Mail for Macintosh displays the Save
As dialog box, as described in the preceding steps. 

Opening a saved memo or text file 

Mail for Macintosh lets you open memos that you've saved from within Mail for 
Macintosh and documents that you've created with other programs such as MacWrite. 
(The document must be saved as a text file.) Both kinds of text documents are opened in 
the same way. 
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To open a saved memo or text file: 

1 Choose Open from the File menu. 

Mail for Macintosh presents the standard open-file dialog box. 

2 Select the memo or text document and click the Open button, or double-click 
the memo icon. 

The contents of the memo or text document appear in a Mail for Macintosh memo 
window. 

Editing a memo 

Mail for Macintosh lets you change both the addressing information and the text of a 
memo. You use the standard Macintosh editing techniques. If you want to edit a memo or 
text file that you've previously saved on a disk, see the preceding section, "Opening a 
Saved Memo or Text File.:: 

Printing a memo 

You can use the standard Macintosh printing method to print an open memo. 

To print a memo: 

1 Make sure that the memo window is open and that it is the frontmost window 
on your screen. 

2 Choose Print from the File menu. 

The standard Print dialog box appears. 

3 Set the printing options and then click the OK button. 

The memo is sent to the printer selected in the Chooser. 
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3 Receiving Mail 

This chapter tells you how to open and read your electronic mail. It tells you how to 

reply to a memo, forward a memo, and print a memo. This chapter also tells you how to 

save memos as text files and how to move them to another folder. 



Checking for new mail 

As new memos arrive for you, the mail server puts them in the NEWMAIL folder. This 
folder is created automatically by Mail for Macintosh. Figure 3-1 shows the Mail Directory 
window with the NEWMAIL folder. 

Mail Directory t!l§ 

Folder Date From Subject 

-0 
121 1 28-JRN-199 1 MEDIO: :SYSADMIN J..ie I come 

LJ MRIL 

~ 
¢I J¢ Q] 

Figure 3-1 Mail Directory window showing the NEWMAIL folder 

When you log in to the server, the NEWMAIL folder appears if you have new messages 
waiting for you. While you are connected to the server, use the following procedure to 
see if new mail has arrived. 

To check for new mail: 

• Choose Check for New Mall from the Folder menu. 

The server searches for incoming messages. If you have new mail, the NEWMAIL folder 
appears in the Mail Directory window. 

Reading a memo 

You can read memos in the NEWMAIL folder and in any other folder displayed in the 
Mail Directory window. 
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To open and read a memo: 

1 Select the memo in the Mail Directory window. 

If the memo is inside a dosed folder, you'll have to open the folder first by selecting the 
folder and choosing Open Folder from the Folder menu. (You can also open the folder 
by double-clicking its icon.) 

2 Choose Read Memo from the Mail menu, or double-click the memo icon. 

Mail for Macintosh opens the memo. The next figure shows an opened memo. 

::0 
From: MED I 0: : SYSADM I N 
To: MEDIO: :SMITH 
CC: 
Subj: We I come 

Welcome 

28-JAN-1991 17 :39 

Welcome to the exci ting world of electronic mai I ! 

I f you're a cool, wi th-i t user, you have logged in to this mai I server from your 
Mac intosh computer by us i ng the Mail for Mac intosh program. The mail server i s 
access i b Ie, however, from many d iff eren t compu ters and works ta t ions, wh i ch means 
that you can exchange memos with a I I different kinds of peop Ie. 

By connect i ng to the mail server, you can read ma i I sen t to you by other users 
on the network. You can a I so send your own messages. The mail server I ets you 
rep I y to messages, forward messages to 0 ther users, and copy messages to your 
own accoun t on the server. 

NEW MAIL 
The mail server au toma t i ca I I Y pu ts i ncom i ng messages i n the NEWMA I L f 0 I der . 

With the memo window open, you can print the memo, send a reply to the memo's 
author, and forward the memo to another address. You can also save the memo as a text 
file on a disk. The sections that follow describe these procedures. 

• Note After you've read a memo, Mail for Macintosh changes the memo's status icon 
from a picture of the front of an envelope to a picture of the back of an envelope. For an 
explanation of each memo status icon, see Table 1-1 in Chapter 1. • 
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Replying to a memo 

You can respond immediately to a memo that you've received. When you reply to a 
memo, Mail for Macintosh automatically addresses your response to the person who sent 
you the memo. 

To reply to a memo: 

1 Make sure that the memo window is open and that it is frontmost on your 
screen. 

2 Choose Reply to Memo from the Mail menu. 

Mail for Macintosh opens a new memo, already addressed for you. 

~D -- RE: Welcome 

From: SMITH Isteven s. Smi th, CommuniTree Group 

To: ISYSADMIN 

CC: ISMITH 

Subject: IRE: l.Ielcome 

• Note If you've selected the "Include text on Reply" default in the Preferences dialog 
box, the text of the memo to which you are replying appears automatically in the memo 
window. If you've selected the Copy on Reply default in the Preferences dialog box, your 
account user name appears automatically in the Copy (CC) field. See "Mail Defaults" in 
Chapter 1 for information about these defaults. + 

3 Type your message. 

Note that although Mail for Macintosh has already addressed the memo for you, you can 
change any of the addressing information. 

Forwarding a memo 

You can forward a memo that you receive to one or more people on the network. 
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• 

To forward a memo: 

1 Make sure that the memo window is open and that it is frontmost on your 
screen. 

2 Choose Forward Memo from the Mall menu. 

Mail for Macintosh opens a memo window with a copy of the text that you just read, as 
shown in the following figure. Mail for Macintosh automatically enters the subject for 
you, as shown in the next figure. 

0 FWD: Welcome 0 
From: SMITH Isteven s. Smith, Commun I Tree Group I 

To: I I 
CC: ISMITH I 

Subject: IFWD: Welcome I 
from: MEDIO: :SYSADMIN 28-JAN-1991 17:39 ~ To: MEDIO: :SMITH 
CC: , Subj: Welcome 

Welcome to the excl tlng world of electronic mal I! 

IIII' I f you're a cool, with-it user, you have logged in to this mal I server from your 
Mac I ntosh computer by us I ng the Mal I for Mac I ntosh program. The mal I server Is J11 accessible, however, from many di fferent computers and workstations, which means 

I that you can exchange memos with a I I di fferent kinds of people. 

By connec t I ng to the mal I server, you can read ma I I sent to you by other users 
on the network. You can a I so send your own messages. The mal I server lets you 
reply to messages, forward messages to other users, and copy messages to your 
own account on the server. ~ 

J\ll=ll MAIL Q] 

• Note If you've selected the Copy on Forward default in the Preferences dialog box, 
your account user name automatically appears in the Copy (CC) field. See "Mail Defaults" 
in Chapter 1 for infonnation about this default. + 

3 Enter the address (or addresses) of the person (or people) to whom you want 
the memo forwarded. 

4 Choose Send Memo from the Mail menu . 

Chapter 3 Receiving Mail 35 



Printing a memo 

You can use the standard Macintosh printing method to print an open memo. 

To print a memo: 

1 Make sure that the memo window is open and that it is frontmost on your 
screen. 

2 Choose Print from the File menu. 

The standard Print dialog box appears. 

3 Set the printing options and then click the OK button. 

The memo is sent to the printer selected in the Chooser. 

After you've read the memo 

After you've read a memo-and replied to, forwarded, or printed it-you need to decide 
what to do with the memo. It's best to take the memo out of the NEWMAIL folder, so that 
it doesn't get mixed up with incoming memos that you haven't read yet. Unlike some 
mail systems, the PATHWORKS mail server never deletes memos on its own. 

You have several choices: 

• Save the memo as a text file. 

• Move the memo to another folder. 

• Delete the memo from the server. 

The ne:x.1 two sections tell you how to save a memo as a text file and how to move a 
memo. For information on removing a memo from the server, see "Deleting a Memo" in 
Chapter 4. 
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Saving the memo as a text file 

You can save a memo as a text file on any disk drive accessible to your Macintosh 
computer by using the Save and Save As menu commands. Later, you can open the text 
file with Mail for Macintosh as described in "Opening a Saved Memo or Text File" in 
Chapter 2. You can also open the text file with a Macintosh word-processing program 
such as Microsoft Word or MacWrite. 

To save a memo as a text file (for the first time): 

1 Open the memo. 

2 Choose Save or Save As from the File menu. 

The standard Save-As dialog box appears. Mail for Macintosh automatically displays the 
subject of the memo (truncated to 32 characters). 

3 If you want to save the me with a different name, enter the name. 

4 Click the Save button. 

The Mail for Macintosh Save and Save As commands behave the same way that they do in 
other Macintosh programs. After you've saved a memo the first time, you can update the 
text file if you make .changes to it by choosing Save from the File menu. Mail for 
Macintosh automatically updates the text file. You can also save another copy of the 
memo with a new name by choosing Save As from the File menu. Mail for Macintosh 
displays the Save-As dialog box, as described in the preceding steps. 

Moving the memo to another folder 

You can keep the memo on the server by moving it to another folder, such as the MAIL 
folder. Figure 3-2 shows the MAIL folder containing several memos that have been 
moved to it. 
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Mail Directory 
Folder Date From 

e:J NEWMt:lIL 

1:21 1 29-NOU- 1990 MEO I 0 : : ORS I NO 
1:21 2 4-DEC-1990 MEDIO: :ORSINO 
1:21 3 22-Jt:lN-1991 MED I 0: : SYSADN I N 

¢ 

Subject 

Treat i se on tomatoes 
Bes t res tauran ts i n town 
Welcome 

Figure 3-2 A list of memos moved to the MAIL folder 

By default, Mail for Macintosh automatically moves memos that you've read from the 
KE\VMAIL folder to the MAIL folder. See "Setting Your Preferences" in Chapter 1. 

See Chapter 4 for more information about organizing your mail. 
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4 Organizing Your Mail 

You can use folders on a PATHWORKS mail server to organize your electronic mail. This 

chapter tells you how to move memos from one folder to another, copy memos, and 

delete memos. 



About folders 

As decribed in Chapter 1, the PATHWORKS mail server keeps your electronic mail in 
various folders. The set of folders that appears in your Mail Directory window depends 
on whether or not you've received any new messages and how you've arranged existing 
memos in your account; empty folders are not listed in the window. 

Mail for Macintosh automatically creates three folders on the server, as they are 
needed: 

• NEWMAIL 

• MAIL 
• WASTEBASKET 

The NEWMAIL folder typically contains incoming memos that you haven't read. The 
MAIL folder is the standard folder for mail that you've already read. (By default, Mail for 
Macintosh automatically moves memos that you've read to this folder. See "Mail Defaults" 
in Chapter 1.) The WASTEBASKET folder holds memos that you want to delete from the 
server. 

Mail for Macintosh also lets you create your own folders as you need them to 
organize your mail. You can have as many different folders on the server as you like. You 
create a new folder by typing a new folder name in the Move Memo dialog box during 
the process of moving or copying a memo. 

Note that while there is no direct way to rename a folder, you can always move mail 
from one folder to another. If you move the contents of a folder to a new folder, which 
you create and name, the server deletes the original folder (because it is now empty) and 
stores your mail in the new folder. In effect, you have renamed the folder. 

Figure 4-1 shows the Mail Directory window with a typical set of folders. 
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Mail Directory ~ 
Folder Date From Subject 

{? 
181 1 28-JAN-1991 MEDIO: :SYSADMIN Welcome 

LJ MAIL 

LJ WASTEBASKET 

~ 
I¢I I¢ IQ] 

Figure 4-1 Typical folders in the Mall Directory window 

Marking or unmarking a memo 
Mail for Macintosh lets you put a check mark in front of memos in the Mail Directory 
window. You might want to mark a memo in this manner as a reminder to read or 
otherwise dispose of the memo at some later time. By choosing Select Marked Memo(s) 
from the Mail menu, you can also select at once all of the marked memos in a folder, and 
then move, copy, or delete them as a group. (The procedures for moving, copying, and 
deleting a group of memos appear in following sections.) 

To mark a memo: 

1 Select the memo in the Mail Directory window. 

2 Choose Mark Memo from the Mail menu. 

A check mark appears in front of the memo. 
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Mail Directory 
Folder Date From 

e:J NEI-IMAIL 
eg MAIL - 3 Message<s> 

121 1 29-NOU- 1990 MED I 0: : ORS I NO 
121 2 4-DEC-1990 MEDIO: :ORSINO 

I-IASTEBASKET 

Subject 

Treatise on tomatoes 
Best restaurants in town 

• Note Memos that you've marked remain marked even when you log out of and log 
back in to the mail server. • 

If you want to remove a mark. you can. 

To unmark a memo that you've previously marked: 

1 Select the memo in the Mail Directory window. 

2 Choose Unmark Memo from the Mail menu. 

The check mark in front of the memo disappears. 

Moving a memo 

Moving a memo from one folder to another is the basic method that you use to organize 
your electronic mail. You can move memos from one folder to another existing folder or 
to a new folder that you create from the Move Memo dialog box. 

To move a memo into another folder: 

1 Open the memo or select the memo in the Mail Directory window. 

2 Choose Move Memo from the Mail menu. 

The Move Memo dialog box appears. 
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MOlle Memo to which folder? 

NEWMRIL 

I( MOlle )) Cancel 

3 Select the folder to which you want the-memo moved or type the name of a new 
folder. 

When you enter a new name in the text field near the bottom of the dialog box (and click 
the Move button), Mail for Macintosh automatically creates a new folder. The memo that 
you are moving is placed in the new folder. 

4 Click the Move button. 

Mail for Macintosh dims the status icon of the memo you are moving, as shown in the 
next figure. 

Mail Directory 0-
Folder Date From Subject 

esJ NEWMAIL - 1 Message(s) {t 

LJ MRIL 

LJ J.JRSTEBASKET 

{} 
¢I 10 I2J 

Mail for Macintosh updates the Mail Directory window when you open another folder or 
the next time you log in to the server. At that time, the memo that you moved is listed in 
the destination folder. 
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Moving several memos at once 
Mail for Macintosh lets you move two or more memos at the same time. You can do this 
by selecting the group of memos that you want to move before choosing the Move Memo 
menu command. 

To move a group of memos: 

1 Select the memos that you want to move in the Mall Directory window. 

2 Choose Move Memo from the Mall menu. 

The Move Memo dialog box appears. 

Moue Memo to which folder? 

NEWMAIL 

t Moue )1 Cancel 

3 Select the folder to which you want the memos moved or type the name of a 
new folder. 

When you enter a new name in the text field near the bottom of the dialog box (and click 
the Move button), Mail for Macintosh automatically creates a new folder. 

4 Click the Move button. 

Mail for Macintosh dims the status icons of the memos that you are moving, as shown in 
the next figure. 

44 Mail for Macintosh User's Guide 



Moil Directory 
Folder Date From Subject 

L:J NEI-IMRIL 
MRIL - 3 Messa e(s) 

tBI 2 4-DEC-1990 MED I 0: : ORS I NO Best restaurants in town 

L:J I-IRSTEBRSKET 

Mail for Macintosh updates the Mail Directory window when you open another folder or 
the next time you log in to the server. At that time, the memos that you moved are listed 
in the destination folder. 

Copying a memo 

If you want a memo to be listed in the contents of more than one folder, you can copy 
the memo to each folder in which you want it to appear. You copy a memo to one folder 
at a time, but you can repeat the copy operation to put the memo in as many folders as 
you want. This procedure is much the same as that for moving a memo. However, when 
you copy a memo, Mail for Macintosh creates a duplicate of the memo in the folder to 
which you copy it. The original memo remains in its original folder. 

To copy a memo: 

1 Open the memo or select the memo in the Mail Directory window. 

2 Choose Copy Memo from the Mall menu. 

The Copy Memo dialog box appears. 
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Copy Memo to which folder? 

NEWMRIL 

I( Copy )1 Cancel 

3 Select the folder to which you want the memo copied or type the name of a new 
folder. 

When you enter a new name in the text field near the bottom of the dialog box (and click 
the Copy button), Mail for Macintosh automatically creates a new folder. The memo that 
you are copying is placed in the new folder. 

4 Click the Copy button. 

Mail for Macintosh places a copy of the memo in the folder that you selected. 

Copying several memos at once 

Mail for Macintosh lets you copy two or more memos at the same time. You can do this 
by selecting the group of memos that you want to copy before choosing the Copy Memo 
menu command. 

To copy a group of memos: 

1 Select the memos that you want to copy in the Mall Directory window. 

2 Choose Copy Memo from the Mall menu. 

The Copy Memo dialog box appears. 
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Copy Memo to which folder? 

NEWMRIL IQ 

t Copy )1 Concel 

3 Select the folder to which you want the memos copied or type the name of a 
new folder. 

When you enter a new name in the text field near the bottom of the dialog box (and click 
the Copy button), Mail for Macintosh automatically creates a new folder. 

4 Click the Copy button. 

Mail for Macintosh places copies of the memos in the folder that you selected. 

Deleting a memo 

When you have read a memo and do not need to keep a copy on the server, you can 
delete the memo. Deleting unneeded memos conserves disk space on the host computer 
and helps to keep your Mail Directory window from becoming cluttered with useless 
information. 

• Note If you want to save a copy of the memo on a Macintosh disk before deleting 
the memo from the server, see "Saving a Memo on a Disk" in Chapter 2 or "Saving the 
Memo as a Text File" in Chapter 3 .• 

Deleting a memo is actually a two-step process: 

Chapter 4 Organizing Your Mail 47 



1. Moving the memo to the WASTEBASKET folder 

2. Purging the memo 

The first step merely marks the memo with the trash can status icon and moves it to 
the WASTEBASKET folder. However, the memo remains on the server until you purge 
the deleted memo. The two-step procedure is a safety precaution and is analogous to 
dragging a file to the Trash icon on the Finder desktop and then choosing Empty Trash. 
After you've deleted a memo, you can still retrieve the memo from the WASTEBASKET 
folder until you perform a purge operation. The memos remain in the WASTEBASKET 
folder even if you quit or log out; they will still be there when you log back in. Once 
you've purged deleted memos, they are gone forever. 

To delete a memo (that is, move it to the WASTEBASKET folder): 

1 Open the memo or select the memo in the Mail Directory window. 

2 Choose Delete Memo from the Mail menu. 

Mail for Macintosh shows that you want to delete the memo by changing the status icon 
for the memo to a small trash can. 

Folder Date From 

eg NE~MAIL - 1 Message(s) 

LJ MAIL 
WASTEBASKET 

Mail Directory 0;; 
Subject 

For now, the memo remains in its folder. Mail for Macintosh creates the WASTEBASKET 
folder Of necessary) and moves the memo to it when you open another folder or when 
you log out and then log back in to the server-whichever occurs sooner. 

To purge deleted memos: 

• Choose Purge Deleted Memos from the Mail menu. 
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All the memos that you've deleted are now permanently and irretrievably removed from 
the server. 

When you purge the memos in the WASTEBASKET folder, the WASTEBASKET folder 
disappears until you delete memos again. 

Deleting several memos at once 

Mail for Macintosh lets you delete two or more memos at the same time. You can do this 
by selecting the group of memos that you want to delete before choosing the Delete 
Memo menu command. 

To delete a group of memos: 

• Select the memos that you want to delete in the Mall Directory window. 

All of the memos that you deleted now have the trash can status icon. The next time that 
the Mail Directory window is updated, Mail for Macintosh will move these memos to the 
WASTEBASKET folder. 

Remember that deleted memos remain on the server until you purge the~. 

To purge deleted memos: 

• Choose Purge Deleted Memos from the Mall menu. 

Any memos that you've marked for deletion are now permanently and irretrievably 
removed from the server. 
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5 Quitting Mail for Macintosh 

This chapter tells you how to conclude a session with a PATHWORKS mail server by 

logging out of the server and by quitting Mail for Macintosh. 



Closing the connection to the server 

When you have finished reading, sending, and organizing your mail, you can close your 
connection to the mail server either by logging out or by quitting the Mail for Macintosh 
program. 

Logging out of the server 

Logging out of the server closes the connection between your Macintosh computer and 
the server without quitting Mail for Macintosh. If you have finished using the server but 
want to continue using Mail for Macintosh, or you want to connect to a different server, 
you must log out. 

To log out of the server: 

• Choose Logout from the Server menu. 

If you want to log in to another server, see "Logging In to a Different Server" in Chapter 1. 

Quitting the Mail program 

The quickest way to end a session with the server is to quit the Mail for Macintosh 
program. Quitting Mail for Macintosh automatically logs you out of the mail server before 
closing Mail for Macintosh. 

To quit Mail for Macintosh: 

• Choose Quit from the File menu. 
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Appendix A: Menu Reference 

This appendix describes each of the Mail for Macintosh menus. 



Mail for Macintosh menus 

Mail for Macintosh has seven menus, as shown in Figure A-l. 

( • File Edit Mail Folder Seruer Windows 

Figure A-I TheMail for Macintosh menu bar 

The following sections describe each of the menus. 

Apple menu (.) 

Hbout Mail for Macintosh 
H~p ~H 

Figure A-2 The Apple menu 

About Mail for Macintosh 

About Mail for Macintosh displays a dialog box giving the version number and 
copyright notice for the Mail for Macintosh program, as shown in Figure A-3. 

mamaamDlM 
Donald Eastlake 
Darnell Gadberry 
Eirlkur Ha IIgrlmsson 

Jay Krutavas Mail for Macintosh ® 

Copy right © 1 9'31 by 
Digitil Equipment Corporation 

This program 'vias written ..... ith MacApp® ©Apple Computer, Inc. 1985-1991 

Figure A-3 About the Mail for Macintosh program dialog box 
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Help 

Help opens the Mail for Macintosh on-line help system. Figure A-4 shows the first help 
screen. 

loIelcome to Mai I for Macintosh 
Help. The Mail for Macintosh 
Help offers on-I ine information 
about Mai I for Macintosh and 
each of i ts menu items. 

To use Mail for Macintosh Help, 
doub I e-c lick the top icon the 
right hand side of the Help box 
that you want information on. 
The Help text for that topic 
wi II appear on the left side of 
the Help box. 

Help 

~ Keyboard Shortcuts 
Preference Settings 
The Mail Directory loIindow 
The New Memo loIindow 
The Read Memo 101 i ndow 
Creating and Sending a Memo 
Reading Memos 
Replying to a Memo 
Mark i ng Memos 
All About Folders 
Creating a new folder 
Deleting a folder 

Done 

Figure A-4 The on-line help screen 

To learn how to use the help system, see "Getting Help" in Chapter 1. 

File menu 

Open... SCO 
Close... scw 
S8lJe... SCS 
SOlJe As ••• 

P8g~ Setup 
Print SCP 

Quit SCQ 

Figure A-5 The File menu 

New Memo 

New Memo opens a new memo window. You use this command to create a memo to 
send to another user on your network. See "Creating a Memo" in Chapter 2. 
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Open 

Open opens an existing text file and displays it in a memo window. You use this 
command to open memos that you created with Mail for Macintosh and saved as text 
files. You can also use this command to open text documents that you've created with 
other programs. 

Close 

Close closes the frontmost memo window. 

Save 

Save saves the memo in the active (frontmost) window as a text file. 

Save As 

Save As saves a copy of the active memo as a text file under a new name. 

Page Setup 

Page Setup displays the standard Page Setup dialog box, which lets you specify settings 
and options for printing memos. The version of this dialog box that appears depends on 
the type of printer you have selected in the Chooser window. Figure A-6 shows the 
LaserWriter® version (for System 6.0.5) of this dialog box. See your Macintosh System 
Software User's Guide for information about the settings and options. Also see "Printing a 
Memo" in either Chapter 2 or Chapter 3. 

laserWriter Page Setup 5.2 

Paper: @ US letter 0 84 letter 0 Tabloid 
o US legal 0 85 letter 

Reduce or l"m'l~o 
Enlarge: 

Orientation 

~ 

Printer Effects: 
[2J Font Substitution? 
[2J TeHt Smoothing? 
[2J Graphics Smoothing? 
[2J Faster 8itmapPrinting? 

Figure A-6 The LaserWriter Page Setup dialog box 
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( Cancel] 

(options) 

Help 



Print 

Print displays the Print dialog box, which allows you to print the memo in the frontmost 
window. The version of this dialog box that you see depends on the type of printer you 
have selected in the Chooser window. Figure A-7 shows the LaserWriter version (for 
System 6.0.5). See your Macintosh System Software User's Guide for information about the 
print settings. Also see "Printing a Memo" in either Chapter 2 or Chapter 3. 

LaserWriter "LaserWriter II NTH" 5.2 n OK B 
cOPles:I'-1 Pages: @ All 0 From: 0 To: 0 [cancel) 

Couer Page: @ No 0 First Page 0 Last Page Help 

Paper Source: @ Paper Cassette 0 Manual Feed 

Figure A-7 The LaserWriter Print dialog box 

Quit 

Quit logs you out of the server and closes Mail for Macintosh. See Chapter 5, "Quitting 
Mail for Macintosh." 

Edit menu 

Undo 882 

Cut 88H 
Copy 88C 
Paste 88U 
Clear 
Select All 88A 

Show Clipboard 

Figure A-8 The Edit menu 

The Edit menu contains the standard Macintosh editing commands. These commands 
behave in the same way that they do in other Macintosh programs. If you are unfamiliar 
with how these commands work, see your Macintosh System Software User's Guide. 
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Mail menu 

Send Memo OOT 
Read Memo 

Reply to Memo OOR 
Forward Memo OOF 

Moue Memo OOM 
Copy Memo 

Mark Memo OOK 
Unmark Memo 
Select Marked Memo(s) 

Delete Memo 000 
Purge Deleted Memos 

Preferences 

Figure A-9 TheMail menu 

Send Memo 

Send Memo sends the active memo, according to the addressing information that you've 
entered at the top of the memo. See "Sending a Memo" in Chapter 2. 

Read Memo 

Read Memo opens the memo that is currently selected in the Mail Directory window. 
Read Memo is dimmed until you select a memo in the Mail Directory window. See 
"Reading a Memo" in Chapter 3. 

Reply to Memo 

Reply to Memo lets you send a reply to the sender of the active memo. When you 
choose Reply to Memo, Mail for Macintosh opens a' new memo window and 
automatically addresses the new memo to the user to whom you are replying. See 
"Replying to a Memo" in Chapter 3. 
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Forward Memo 

Forward Memo lets you edit and send the active memo to another user on the network. 
When you choose Forward Memo, Mail for Macintosh opens a new memo window 
containing a copy of the original memo's text. You complete the forwarding process by 
addressing the memo to another user and choosing Send Memo from the Mail menu. See 
"Forwarding a Memo" in Chapter 3. 

Move Memo 

Move Memo lets you move a memo from one folder to another on the mail server. See 
"Moving a Memo" in Chapter 4. 

Copy Memo 

Copy Memo lets you copy a memo from one folder to another on the mail server. See 
"Copying a Memo" in Chapter 4. 

Mark Memo 

Mark Memo lets you place a check mark in front of a memo in the Mail Directory 
window. You might want to mark a memo as a reminder to do something with the memo 
at a later date. By choosing Select Marked Memo(s) from the Mail menu, you can also 
select at once all of the marked memos in a folder, and then move, copy, or delete them 
as a group. Because the status information is saved on the server itself, memos that have 
been marked remain marked even after you log out of and back in to the server. See 
"Marking or Unmarking a Memo" in Chapter 4. 

Unmark Memo 

Unmark Memo lets you unmark a previously marked memo. See "Marking or 
Unmarking a Memo" in Chapter 4. 
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Select Marked Memo(s) 

Select Marked Memo(s) selects all of the memos that you've marked with the Mark 
Memo command. You can move, copy, or delete several memos at once after you mark 
the memos and choose Select Marked Memo(s). See "Moving Several Memos at Once," 
Copying Several Memos at Once," and "Deleting Several Memos at Once" in Chapter 4. 

Delete Memo 

Delete Memo moves a memo to the WASTEBASKET folder on the mail server. Once 
you've moved a memo to the WASTEBASKET, you can permanently delete the memo by 
choosing the Purge Deleted Memos command from the Mail menu. See "Deleting a 
Memo" in Chapter 4. 

Purge Deleted Memos 

Purge Deleted Memos permanently removes any memos that you've marked for 
deletion with the Delete Memo command. See "Deleting a Memo" in Chapter 4. 

Preferences 

Preferences displays the Preferences dialog box, shown in Figure A-lO. The Preferences 
dialog box lets you set mail defaults, tell Mail for Macintosh if you have changed the 
name of the WASTEBASKET folder, and enter your personal name so that Mail for 
Macintosh can add it to every memo that you send. This dialog box also lets you tell the 
server to forward your incoming mail to another account. See "Setting Your Preferences" 
in Chapter 1. 
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Preferences 

Per-sonol Nome: 

Forwarding Rddress: 

Wostebosket Nome: I '-W_A_S_T_EB_A_S_KE_T ______ ~ 

181 Move opened memos to MAIL folder o Copy on Send 

o Confirm Save after sending new memo o Copy on Reply 

o Include text on Reply o Copy on Fonrard 

( Cancel) I[ OK )) 

Figure A-IO The Preferences dialog box 

Folder menu 

Check For New Mail XU 

Open Folder 
Close Folder 

Figure A-II The Folder menu 

Check for New Mail 

Check for New Mall prompts the mail server to look for incoming memos that may 
have arrived after you logged in. Any new memos will appear in the NEWMAIL folder. 
See "Checking for New Mail" in Chapter 3. 

Open Folder 

Open Folder opens the folder that you select in the Mail Directory window. The folder's 
contents are listed in the Mail Directory window and the folder's icon changes t~ an open 
folder. When you open a folder, the previously opened folder is closed. 
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Close Folder 

Close Folder closes the currently open folder. In the Mail Directory window, the list of 
the folder's contents disappears and the folder's icon changes to a closed folder. 

Server menu 

Login sgL 
Logout 

Figure A-12 The Server menu 

Login 

Login establishes a connection between your Macintosh computer and the server. See 
"Logging In to the Mail Server" in Chapter 1. 

Logout 

Logout closes the connections between your Macintosh computer and the server. See 
"Logging Out of the Server" in Chapter 5. 

Connection 

Connection displays the Connection Configuration dialog box, which lets you choose 
and configure a connection tool. The connection settings that appear in the dialog box 
depend on the connection tool that you chose in the Method pop-up menu. Figure A-13 
shows the Connection Configuration dialog box with the settings for the DECnet 
Connection Tool. See "Specifying and Configuring C:t Connection Tool" in Chapter 1. 
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Connection Configuration ( Cancel J 
Method: I DECnet Tool I (( OK 1) 

User: ISmith I 

mamlllD Node Names 
DUE V ~ DECnet for Macintosh HAL 

Node: I MEDI.Q I HUEY II LAUREL 
LUEY 

I PLUNGE 
SPIFFY 
SPINNY 

Version 1.1 Copyright © 1991 Thursby Software Systems, Inc. 

Figure A-13 The Connection Configuration dialog box for the DECnet 
Tool 

Windows menu 

Meeting schedule 
""'New Year's greeting 

Untitled-4 

Figure A-14 The Windows menu 

The Windows menu lists the currently open memo windows, indicating the currently 
active memo with a check mark. You can bring a memo to the front by choosing its name 
from the Windows menu. 
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Appendix B: Troubleshooting 

This appendix describes potential problems that you might have when you use Mail for 

Macintosh and suggests possible solutions. 



Problems and solutions 

This section describes problems that might occur as you use Mail for Macintosh. Try 
solving the problem by following the suggested steps. If the problem persists, see your 
system administrator. 

Some features of the Macintosh computer work differently if you are using Macintosh 
Operating System software version 6.0.x than they do if you are using version 7.0. The 
subsections "System Software Version 6.0.xOnly" and "System Software Version 7.0 
Only" contain troubleshooting information that is specific to each environment. 

You are unable to log in to the server. 

The most common cause of this problem is that you've entered an invalid user name, 
password, or both. The user name must be the name of your mail server account as 
provided to you by the system administrator. Your original password was also provided 
by the system administrator, but if you are a VMS user, it is possible for you to change the 
password. Try logging in again, making sure that you enter your account user name and 
current password correctly. If an incorrect user name appeared automatically in the Login 
dialog box, you should correct your user name entry in the Connection Configuration 
dialog box. 

The NEWMAIL folder does not appear in the Mail Directory window. 

The ~r:WMAIL folder appears when you've received new incoming messages. The 
NEWMAIL folder won't be visible in your Mail Directory window if you've never received 
mail or if you moved memos from that folder to another folder. (For information on 
moving memos, see "Moving a Memo" in Chapter 4.) 

By default, Mail for Macintosh automatically moves memos that you've read from the 
NE\VrvWL folder to the rvIAIL folder. See "Setting Your Preferences" in Chapter 1. 

66 Mail for Macintosh User's Guide 



You were disconnected from the server. 

There are a number of problems that might occur which would interrupt your connection 
to the server. Report the problem to your system administrator. 

You deleted a memo, but it still appears on the server. 

When you choose Delete Memo from the Mail menu, Mail for Macintosh moves the 
memo from its current folder to the WASTEBASKET folder, where it waits to be removed 
from the server. To permanently remove the memo, choose Purge Deleted Memos from 
the Mail menu. For more information on removing memos, see "Deleting a Memo" in 
Chapter 4. 

There are VMS programs that let you change the name of your WASTEBASKET folder on 
the mail server. If you've changed the name of the WASTEBASKET folder, you must enter 
the new name in the Preferences dialog box. If you do not, the Delete Memo and Purge 
Deleted Memos menu commands will not work. See "Wastebasket Name" in Chapter 1. 

The WASTEBASKET folder does not appear in the Mail Directory window. 

The WASTEBASKET folder appears in the Mail Directory window only if you have 
deleted one or more memos. Mail for Macintosh stores deleted memos in the 
WASTEBASKET folder until you permanently remove the memos by choosing Purge 
Deleted Memos from the Mail menu. For more information on removing memos, see 
"Deleting a Memo" in Chapter 4. 

There are VMS programs that let you change the name of your WASTEBASKET folder on 
the mail server. If you've changed the name of the WASTEBASKET folder, you must enter 
its new name in the Preferences dialog box. See "Wastebasket Name" in Chapter 1. 

The connection tool that you want to use does not appear in the Connection 
Configuration dialog box. 

Mail for Macintosh supports both the AppleTalk-DECnet Connection Tool and the 
DECnet Connection Tool. At least one of these tools must be installed on your Macintosh 
computer. See the section "Installing Mail for Macintosh" in Chapter 1. 

Appendix B Troubleshooting 67 



Your Macintosh computer hangs (does not respond to the mouse and keyboard 
actions). 

Your Macintosh may hang for a minute or so when you select an EtherTalk icon or when 
you start your computer. The computer can hang if it is not correctly connected to the 
Ethernet cable or the Ethernet card is not configured correctly. See the documentation for 
the Ethernet card that you are using. 

You can't select devices connected to the printer port of your Macintosh 
computer. 

If the Chooser does not let you select an ImageWriter® or other device connected to the 
printer port while the EtherTalk network connection is selected, you may have an old 
version of the Chooser on your Macintosh. You must have Chooser version 3.4 (or later) 
to select a device on the printer port. Use the Installer program from the System Tools disk 
(version 6.0.4 or later) to update your System file. The Installer automatically updates the 
Chooser. Here's a checklist to consult whenever you have trouble with Ethernet: 

• Are all cables secure? 

Make sure that the network cable to your Ethernet card is secure at all connections. 
Also check the network cable to the host computer running the mail server that you 
are trying to use. Contact your system administrator if you are uncertain about cable 
configuration. 

• Is your Ethernet card installed and set correctly? 

Shut down your Macintosh and make sure that the Ethernet card is firmly seated in its 
slot. Also, make sure that any jumpers and switches are set properly. See the 
documentation for your Ethernet card. 

System software version 6.0.x only 

The following troubleshooting information is specific to system software version 6.0.x. 
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The Control Panel is missing. 

The Control Panel is present on all startup disks unless you have removed it with the 
Font/DA Mover. If you're using more than one startup disk, your Macintosh may switch 
to a disk without the Control Panel installed. The icon of the current startup disk is in the 
upper-right corner of the desktop. 

Use the Installer application program from the System Tools disk (version 6.0.4 or 
later) to update your System file. The Installer automatically reinstalls the Control Panel. 

The Network icon is missing from the Control PaneL 

One of the following conditions exists: 

• You don't have the EtherTalk 2.0 software installed correctly on your startup disk. See 
the documentation for your Ethernet card. 

• The Network icon has been removed from your System Folder. You must reinstall the 
EtherTalk 2.0 software. See the documentation for your Ethernet card. 

• Your startup disk has the wrong version of the Control Panel. You must use version 
3.1 (or later). The version number appears in the lower-left corner of the Control 
Panel. Use the Installer program from the System Tools disk (version 6.0.4 or later) to 
update your System file. The Installer automatically reinstalls the Control Panel. 

You can't select the Network icon in the Control PaneL A message appears, 
advising you that the network package has not been installed correctly. 

The EtherTalk 2.0 software is not installed properly on your startup disk. See the 
documentation for your Ethernet card. 

The EtherTalk icon doesn't appear in the Control Panel after you click the 
Network icon. 

One of the following conditions exists: 

• You don't have the EtherTalk 2.0 software installed correctly on your startup disk. See 
the documentation for your Ethernet card. 

• The EtherTalk icon has been removed from your System Folder. You must reinstall 
the EtherTalk 2.0 software. See the documentation for your Ethernet card. 
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• There is no Ethernet card in your computer, or the card is not working properly. If a 
card is installed, see its documentation. 

Two or more EtherTalk icons appear in the Control Panel when you click the 
Network icon. 

One of the following conditions exists: 

• You have multiple Ethernet cards installed. The number in parentheses next to each 
icon's name identifies the slot containing the card. 

• One or more earlier versions of EtherTalk software exist on your startup disk in 
addition to EtherTalk version 2.0. Any version earlier than version 2.0 is identified by 
a single-arrow icon; version 2.0 (or later) is identified by a double-arrow icon. 
PATHWORKS for Macintosh requires that you use EtherTalk version 2.0. See the 
documentation for your Ethernet card. 

If you want to remove the earlier version of EtherTalk, find its icon in the System 
Folder and drag it to the Trash. 

You can't select the EtherTalk icon in the Control Panel. A message appears, 
advising you that an error occurred while trying to install EtherTalk. 

You did not start your computer with an EtherTalk startup disk or the disk that you used 
is damaged. Try reinstalling the EtherTalk 2.0 software. See the documentation for your 
Ethernet card. 

You are unable to select an EtherTalk icon in the Control Panel to switch the 
network connection. You get a message that the connection cannot be changed 
now, or that doing so will disrupt a critical service that your computer provides 
(such as access to an AppleShare ftIe server or a router). 

Quit all applications and try switching the network connection again. If you still can't 
switch network connections, and you don't mind disrupting services that your computer 
provides or is using, shut down your Macintosh. Then restart your computer, using a 
startup disk that permits network-connection changes. Finally, try switching the network 
connection again. 
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System software version 7.0 only 

The following troubleshooting information is specific to system software version 7.0. 

The Control Panels folder is missing from your System Folder. 

The Control Panels folder is present on all startup disks unless you throw it in the Trash. 
Use the Installer application program from the System Tools disk (version 7.0) to update 
your system software. The Installer automatically reinstalls the Control Panels folder. 

The Network icon is missing from the Control Panels window. 

One of the following conditions exists: 

• The EtherTalk 2.0 software is not installed correctly on your startup disk. See the 
documentation for your Ethernet card. 

• The Network panel has been removed from the Control Panels folder. You must 
reinstall the EtherTalk 2.0 software. See the documentation for your Ethernet card. 

You can't select the Network icon in the Control Panels window. A message 
appears, advising you that the network package has not been installed 
correctly. 

The EtherTalk 2.0 software is not installed properly on your startup disk. See the 
documentation for your Ethernet card. 

The EtherTalk icon doesn't appear after you open the Network icon in the 
Control Panels window. 

One of the following conditions exists: 

• The EtherTalk 2.0 software is not installed correctly on your startup disk. See the 
documentation for your Ethernet card. 

• The EtherTalk icon has been removed from the Extensions folder in your System 
Folder. You must reinstall the EtherTalk 2.0 software. See the documentation for your 
Ethernet card. 
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• No Ethernet card is installed in your Macintosh computer, or the card is not working 
properly. If a card is installed, see its documentation. 

Two or more EtherTalk icons appear when you open the Network icon in the 
Control Panels window. 

One of the following conditions exists: 

• You have multiple Ethernet cards installed. The number in parentheses next to each 
icon's name identifies the slot containing the card. 

• One or more earlier versions of EtherTalk software exist on your startup disk in 
addition to EtherTalk version 2.0. Any version earlier than version 2.0 is identified by 
a single-arrow icon; version 2.0 (or later) is identified by a double-arrow icon. 
PATHWORKS for Macintosh requires that you use EtherTalk version 2.0. See the 
documentation for your Ethernet card. 

If you want to remove the earlier version of EtherTalk, find its icon in the Extensions 
folder (inside your System Folder) and drag the icon to the Trash. 

You can't select the EtherTalk icon in the Network panel. A message appears, 
advising you that an error occurred while trying to install EtherTalk. 

You did not start your computer with an EtherTalk startup disk, or the disk that you used 
is damaged. Try reinstalling the EtherTalk 2.0 software. See the documentation for your 
Ethernet card. 

You are unable to select an EtherTalk icon in the Network panel to switch the 
network connection. A message appears, telling you that the connection cannot 
be changed now, or that doing so will disrupt a critical service that your 
computer provides (such as access to an AppleShare fue server or a router). 

Quit all applications and try switching the network connection again. If you still can't 
switch network connections, and you don't mind disrupting services that your computer 
provides or is using, shut down your Macintosh. Then restart your computer, using a 
startup disk that permits network-connection changes. Finally, try switching the network 
connection again. 
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Glossary 

account A defined relationship between you and the 
mail server. To establish this relationship, your system 
administrator adds you to a list of users who have 
permission to log in to the server and use the server to 
exchange electronic mail.Your account includes your 
user name, a password, and a special directory on the 
host computer that stores your electronic mail. See also 
directory, electronic mail, log in, mail server, 
password, user name. 

addressing information A series of text fields at the 
top of a memo window that specify the sender of the 
memo, the person or persons who receive the memo, 
the person or persons who get copies of the memo, and 
the subject of the memo. See also memo window. 

ADSP See AppleTalk Data Stream ProtocoL 

ADSP driver A system file that provides the AppleTalk 
Data Stream Protocol on your Macintosh computer. See 
also AppleTalk Data Stream ProtocoL 

AppleTalk Data Stream Protocol (ADSP) An 
AppleTalk communications protocol that lets you 
establish connections between applications on a 
network. ADSP allows full-duplex, byte-stream 
connections. Data flow on an ADSP connection is 
reliable; ADSP guarantees that data bytes are delivered 
in the same order as that in which they were sent and 

that they are free of duplicates. See also 
communications protocoL 

AppleTalkIDECnet Transport Gateway A device 
that translates between AppleTalk and DECnet 
communications protocols on a network. Depending on 
the complexity of the network to which your Macintosh 
is connected, you may have access to more than one 
gateway. See also AppleTalk network system, 
communications protocol, DECnet, gateway. 

AppleTalk network system A networking 
environment that includes computers and other devices. 
software applications, and AppleTalk protocols that 
govern the interactions between the components. The 
specification for the AppleTalk network system was 
created by Apple Computer, and Macintosh computers 
and LaserWriter printers have AppleTalk capabilities 
built in. Other Apple and non-Apple devices may also 
be able to use AppleTalk. For example, AppleTalk for 
VMS allows services and devices running under the VMS 
operating system to communicate by means of 
AppleTalk protocols. See also AppleTalk protocols. 

AppleTalk protocols The set of communication rules. 
or protocols, used in the AppleTalk network system. Set' 
also communications protocoL 

AppleTalk-DECnet Connection Tool A connection 
tool that allows your Macintosh computer to 
communicate with other computers through the 



AppleTalklDECnet Transport Gateway. The AppleTalk
DECnet Tool is installed in your System Folder-in the 
Communications Folder if you are using system 
software version 6.0.x, or in the Extensions Folder if you 
are using system software version 7.0. See also 
AppleTalkIDECnet Transport Gateway, connection 
tool. 

cllent On a network, a combination of a computer and 
software that lets you access services offered by a 
server, such as printing (print server), shared files (file 
server), and so on. The computer that you use to access 
the services is sometimes referred to as the client, but 
there is always a client software component. In most 
cases, the client software is located on your computer 
and the server resides on a remote computer. See also 
server, mall server. 

communications protocol A set of rules that 
determine how information is transmitted and received 
by communicating devices. The communications 
protocols built into networking software perform such 
tasks as acquiring commands from the application you 
are using, making sure devices are responding properly, 
controlling the connection to the network, and moving 
data between devices. See also AppleTalk protocols, 
DECnet. 
Communications Toolbox See Macintosh 
Communications Toolbox. 
communications tools Pieces of software that supply 
the communications functions that your Macintosh 
needs to communicate with another computer. 
Communications tools fall into three categories: 
connection tools, file-transfer tools, and terminal 
emulation tools. Each type of tool manages a different 
aspect of the communication process. See also 
connection tooL 
configure In the context of Mail for Macintosh, to give 
a connection tool the necessary settings for 
communicating with the Digital network and mail 
server. See also connection tooL 
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connection method The type of connection tool used 
to establish the connection between your Macintosh 
computer and the network. See also connection tooL 
connection tool One of the three types of 
communications tools. A connection tool determines the 
type of connection that is established between your 
Macintosh computer and the host computer or Digital 
network. Examples: AppleTalk-DECnet Tool and 
DECnet Tool. See also communications tools. 
DECnet The set of network communications protocols 
most often used on Digital networks, and used on other 
kinds of systems as well. DECnet offers a flexible 
protocol architecture that works with a number of 
different network media and low-level protocols. See 
also communications protocol. 
DECnet Connection Tool A connection tool that 
allows your Macintosh computer to communicate with 
other computers using the DECnet communications 
protocols. The DECnet Tool is installed in your System 
Folder-in the Communications Folder if you are using 
system software version 6.0.x or in the Extensions 
Folder if you are using system software version 7.0. See 
also communications protocol, connection tooL 

defaults Predetermined settings. Mailior Macintosh 
has defaults for forwarding memos, replying to memos, 
sending memos, and reading memos. 

delete To move a memo to the WASTEBASKET folder 
so that you can remove it from the mail server. When 
you delete a memo, its status changes to "deleted." To 
remove the memo permanently from the server, you 
purge the memo after deleting it. See also memo, 
purge, status, mail server, WASTEBASKET folder. 

directory A lis.t of files on a storage device. Directories 
usually contain a hierarchical set of subdirectories. 

distribution list A list of users to whom you regularly 
send electronic mail. You can create a distribution list 
with certain VMS utility programs and use the name of 
the list to send memos to a group of people with Mail 
for Macintosh. See also electronic mail. 



electronic mail Correspondence created on 
computers and exchanged between users on computer 
networks. See also memo. 
Ethernet A high-speed local area network 
environment that uses a variety of cables, such as thick
wire, thin-wire, broadband, twisted pair, and so on. The 
Ethernet specification was developed by Digital 
Equipment Corporation, Intel Corporation, and Xerox 
Corporation. 

Ethernet card A printed circuit board or interface card 
that connects a personal computer, such as a Macintosh, 
to Ethernet and serves as the communications controller 
between the computer and other devices in the Ethernet 
environment. A number of Ethernet cards are available 
for Digital, Apple, and other types of computers. Apple 
provides an Ethernet card called the EtherTalk NB Card. 
See also Ethernet, EtherTalk. 
EtherTaik A high-performance AppleTalk connection. 
EtherTalk consists of an Ethernet interface card, 
AppleTalk software, and Ethernet cabling. EtherTalk 
enables you to use Ethernet cabling in an AppleTalk 
environment. See also AppleTaik network system, 
communications protocol, Ethernet. 
EtherTaik NB Card An Ethernet card provided by 
Apple Computer. See also Ethernet, Ethernet card, 
EtherTalk. 
folder In the context of Mail for Macintosh, a container 
for memos on the mail server that allows you to 
organize your electronic mail. See also NEWMAIL 
folder, WASTEBASKET folder. 

gateway A device that translates between two 
communications protocols on a network. A gateway 
allows network services that use different protocols to 
communicate with each other. See also 
AppleTalkIDECnet Transport Gateway. 
host name The name of the computer that runs the 
mail server that contains your account. See also 
account. 

host computer The computer running the mail server 
to which you connect by using Mail for Macintosh. 

installation The process of adding or changing 
information on a Macintosh computer. For example, the 
Installer application provided with PATHWORKS for 
Macintosh installs software and updates the System file. 
The Installer uses Installer script documents that define 
the software to be installed. 

log in In the context of Mail for Macintosh, to open a 
connection to the mail server. 

log out In the context of Mail for Macintosh, to close a 
connection to the mail server. 

Macintosh Communications Toolbox A set of 
extensions to the Macintosh system software that 
provides Macintosh applications with standard 
communications services and a consistent interface for 
using those services. For example, the MacTerminal 
application program uses the Communications Toolbox 
to let you connect to terminal services. 

mail See electronic mail 

Mail Directory window The window that lists your 
electronic mail and the folders that contain your mail. 
See also electronic mail, folder. 
mail server A server on a computer that provides 
electronic mail services to users on the network. See 
also server. 
mark To flag a memo so that Mail for Macintosh will 
treat it as a member of a group. When you select a 
group of marked memos, you can move, copy, or delete 
all of the memos at once. In the Mail Directory window, 
a marked memo is indicated by a check mark status 
icon. See also memo, status, unmark. 
memo One piece of electronic mail. Also referred to as 
a message. See also electronic mail 

memo window The window that displays a memo in 
Mail for Macintosh. The upper portion of a memo 
window contains addressing information; the lower 
portion contains the text of the memo. See also 
addressing information, memo. 
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message See memo. 
network A collection of interconnected, individually 
controlled computers, the hardware and software used 
to connect them, and the communications protocols that 
govern the exchange of information between the 
computers and other devices. A network allows users to 
share data and peripheral devices such as printers and 
storage media, to exchange electronic mail, and so on. 

network connection The connection between your 
Macintosh computer and the host computer. Mail for 
Macintosh supports both AppleTalk-DECnet and 
D ECnet connections. 

NEWMAIL folder A folder that is created by the mail 
server to hold incoming electronic mail for your 
account. See also folder. 
password A unique word or set of characters that you 
must enter, along with your user name, to gain access to 
the mail server. See also user name. 
preferences A set of options that you can change to 
specify how certain Mail for Macintosh features work. 

protocol See communications protocol. 

purge To permanently remove memos from the mail 
server. Removing memos from the server is a two-step 
process. First, you delete a memo, which changes the 
status of the memo to "deleted" and moves the memo to 
the \V ASTEBASKET folder. Second, you purge the 
memo, which removes the memo from the server 
forever. See also delete, memo, status, mail server, 
WASTEBASKET folder. 
server On a network, a combination of hardware and 
software that provides a particular service such as 
access to shared files (file server), printing (print server), 
electronic mail (mail server), and so on. The 
combination of computer and software that you use to 
access the services is called the client. In most cases, the 
client software is located on your Macintosh computer 
and the server resides on a remote computer. See also 
client, mail server. 
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service Software that performs a particular function on 
a network and that is available to users on the network. 

status The condition of a memo-whether or not you 
have read the memo, if it has been moved to another 
folder, if it is to be deleted, and if it is marked. Each 
memo in the Mail Directory window has an icon that 
indicates the memo's status. See also mark. 
status icon A small picture that appears to the left of 
each memo in the Mail Directory window and indicates 
the memo's status. See also status. 
unmark To remove the mark from a memo that 
includes the memo in a group. See also mark. 
user name The name of your account as provided by 
your system administrator. See also account. 
VMS An operating system that can run on all of Digital's 
VAX computers. 

WASTEBASKET folder The mail folder that contains 
memos you've deleted. Deleted memos remain in the 
WASTEBASKET folder until you purge them. See also 
delete, folder, purge. 
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